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Regulatory Notices 
Regulatory Notices

United States (FCC)

NOTE: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with this instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.

European Union (CISPR 22)

The Dolby® Atmos™ CP850 Cinema Processor and the Dolby Atmos Interface 
DAC3201comply with the EMC requirement of EN55022 and EN55024 when operated in 
accordance with this manual. 

WARNING: This is a class A product. In a domestic environment, this product may cause 
radio interference in which case the user may be required to take adequate measures.

Canada

This Class A digital apparatus complies with Canadian ICES003. Cet appareil de la calsse 
A est conforme à la norme NBM003 de Canada.

China

警告
此为 A 级产品。在生活环境中，该产品可能会造成无线电干扰。在这种情况下，

可能需要用户 对下扰采取切实可行的措施。

Korean

이 기기는 업무용 (A급 ) 전자파적합기기로서 판
매자 또는 사용자는 이 점을 주의하시기 바라
며 , 가정외의 지역에서 사용하는 것을 목적으로
합니다 .
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Regulatory Notices
Important Safety Instructions

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to 

rain or moisture.
7. Clean only with dry cloth.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other 

apparatus (including amplifiers) that produce heat.
9. No naked flame sources, such as lighted candles, should be placed on the apparatus
10. Protect the power cord from being walked on or pinched particularly at plugs, 

convenience receptacles, and the point where they exit from the apparatus.
11. Only use attachments/accessories specified by the manufacturer.
12. Unplug this apparatus when unused for long periods of time.
13. Refer all servicing to qualified service personnel. Servicing is required when the 

apparatus has been damaged in any way, such as powersupply cord or plug is 
damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus 
has been exposed to rain or moisture, does not operate normally, or has been dropped.

14. Do not expose the apparatus to dripping or splashing and no objects filled with liquids, 
such as vases, shall be placed on the apparatus.

15. CAUTION: Troubleshooting must be performed by a trained technician. To reduce the 
risk of electric shock, do not attempt to service this equipment unless you are qualified 
to do so.

16. Do not defeat the safety purpose of the polarized or groundingtype plug. A polarized 
plug has two blades with one wider than the other. A groundingtype plug has two 
blades and a third grounding prong. The wide blade or the third prong is provided for 
your safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet.

17. This apparatus must be earthed (grounded) by connecting to a correctly wired and 
earthed power outlet.

18. Ensure that your mains supply is in the correct range for the input power requirement of 
the unit.

19. In order to reduce the risk of electrical shock, the power cord must be disconnected 
when the power supply assembly is removed.

20. This equipment is designed to mount in a suitably ventilated 19” rack; ensure that any 
ventilation slots in the unit are not blocked or covered.

21. The mains power disconnect device for this unit is the plugin mains cord rather than a 
power switch. The mains cord must remain readily accessible for disconnecting mains 
power.

22. To avoid exposure to dangerous voltages and to avoid damage to the unit, do not 
connect the rearpanel Ethernet port to telephone circuits.
iv  Dolby® Atmos™ Cinema Processor CP850 Software Manual 



Regulatory Notices 
23. As the colors of the cores in the mains lead may not correspond with the colored 
markings identifying the terminals in your plug, proceed as follows:
• The green and yellow core must be connected to the terminal in the plug 

identified by the letter E, or by the earth symbol , or colored green, or green 
and yellow.

• The blue core must be connected to the terminal marked with the letter N or 
colored black.

• The brown core must be connected to the terminal marked with the letter L or 
colored red.

24. This apparatus must be earthed.

PRODUCT ENDOFLIFE INFORMATION

Figure ii-1 CAUTION – Danger of explosion if battery is incorrectly replaced. Replace 
only with the same or equivalent type.   Dispose of used batteries according 
to local law.

This product was designed and built by Dolby Laboratories to provide many years of service, 
and is backed by our commitment to provide highquality support. When it eventually reaches 
the end of its serviceable life, it should be disposed of in accordance with local or national 
legislation. For current information please visit our website: www.dolby.com/environment.

Figure ii-2 This symbol that appears on the unit rear panel and in this manual is 
intended to alert the user to the presence of uninsulated “dangerous” 
voltage within the product’s enclosure that maybe of sufficient magnitude 
to constitute a risk of electric shock to persons.
Figure ii-3  

Figure ii-4 This symbol is intended to alert the user to the presence of important safety 
operating and maintenance instructions.
Figure ii-5  
Dolby® Atmos™ Cinema Processor CP850 Software Manual v   

http://www.dolby.com/environment 


Regulatory Notices
IMPORTANT SAFETY NOTICE

These units comply with safety standard EN609501. These units shall not be exposed to dripping or splashing and no objects filled with liquids, such as coffee cups, shall 
be placed on the equipment. To ensure safe operation and to guard against potential shock hazard or risk of fire, the following must be observed:
o Ensure that your mains supply is in the correct range for the input power requirement of the unit.  
o Ensure fuses fitted are the correct rating and type as marked on the unit.
o The unit must be earthed by connecting to a correctly wired and earthed power outlet.
o The power cord supplied with this unit must be wired as follows:

Live—Brown        Neutral—Blue        Earth—Green/Yellow

IMPORTANT – NOTE DE SECURITE

Ces unités se conformer à la norme de sécurité EN609501. Ne pas exposer ces appareils aux éclaboussures ou aux gouttes de liquide. Ne pas poser d'objets remplis de 
liquide, tels que des tasses de café, sur l'appareil. Pour vous assurer d'un fonctionnement sans danger et de prévenir tout choc électrique ou tout risque d'incendie, veillez à 
ob les recommandations suivantes.
o Le selecteur de tension doit être placé sur la valeur correspondante à votre alimentation réseau.
o Les fusibles doivent correspondre à la valeur indiquée sur le materiel.
o Le materiel doit être correctement relié à la terre.
o Le cordon secteur livré avec le materiel doit être cablé de la manière suivante:

Phase—Brun        Neutre—Bleu        Terre—Vert/Jaune 

WICHTIGER SICHERHEITSHINWEIS

Diese Geräte erfüllen die Sicherheitsnorm EN609501. Die Geräte darf nicht mit Flüssigkeiten (Spritzwasser usw.) in Berührung kommen; stellen Sie keine Gefäße, z.B. 
Kaffeetassen, auf die Geräte. Für das sichere Funktionieren der Geräte und zur Unfallverhütung (elektrischer Schlag, Feuer) sind die folgenden Regeln unbedingt 
einzuhalten:
o Der Spannungswähler muß auf Ihre Netzspannung eingestellt sein.
o Die Sicherungen müssen in Typ und Stromwert mit den Angaben auf dem Gerät übereinstimmen.
o Die Erdung des Gerätes muß über eine geerdete Steckdose gewährleistet sein.
o Das mitgelieferte Netzkabel muß wie folgt verdrahtet werden:

Phase—braun         Nulleiter—blau        Erde—grün/gelb

NORME DI SICUREZZA – IMPORTANTE

Queste unità sono costruiti a norma di sicurezza EN609501. I prodotti non deve essere sottoposto a schizzi, spruzzi e gocciolamenti, e nessun tipo di oggetto riempito con 
liquidi, come ad esempio tazze di caffè, deve essere appoggiato sul dispositivo. Per una perfetta sicurezza ed al fine di evitare eventuali rischi di scossa êlettrica o d'incendio 
vanno osservate le seguenti misure di sicurezza:
o Assicurarsi che il selettore di cambio tensione sia posizionato sul valore corretto.
o Assicurarsi che la portata ed il tipo di fusibili siano quelli prescritti dalla casa costruttrice.
o L'apparecchiatura deve avere un collegamento di messa a terra ben eseguito; anche la connessione rete deve 

avere un collegamento a terra.
o Il cavo di alimentazione a corredo dell'apparecchiatura deve essere collegato come segue:

Filo tensione—Marrone        Neutro—Blu        Massa—Verde/Giallo

AVISO IMPORTANTE DE SEGURIDAD

Estas unidades cumplen con la norma de seguridad EN609501. Estas unidades no debe ser expuesta a goteos o salpicaduras y no deben colocarse sobre el equipo recipientes 
con liquidos, como tazas de cafe. Para asegurarse un funcionamiento seguro y prevenir cualquier posible peligro de descarga o riesgo de incendio, se han de observar las 
siguientes precauciones: 
o Asegúrese que el selector de tensión esté ajustado a la tensión correcta para su alimentación.
o Asegúrese que los fusibles colocados son del tipo y valor correctos, tal como se marca en la unidad.
o La unidad debe ser puesta a tierra, conectándola a un conector de red correctamente cableado y puesto a tierra.
o El cable de red suministrado con esta unidad, debe ser cableado como sigue:

Vivo—Marrón        Neutro—Azul        Tierra—Verde/Amarillo

VIKTIGA SÄKERHETSÅTGÄRDER!

Dessa enheter uppfyller säkerhetsstandarden EN609501. Dessa enheter får inte utsättas för yttre åverkan samt föremål innehållande vätska, såsom kaffemuggar, får ej 
placeras på utrustningen. För att garantera säkerheten och gardera mot eventuell elchock eller brandrisk, måste följande obas:
o Kontrollera att spänningsväljaren är inställd på korrekt nätspänning.
o Konrollera att säkringarna är av rätt typ och för rätt strömstyrka så som anvisningarna på enheten föreskriver.
o Enheten måste vara jordad genom anslutning till ett korrekt kopplat och jordat eluttag.
o Elsladden som medföljer denna enhet måste kopplas enligt foljande:

Fas—Brun        Neutral—Blå        Jord—Grön/Gul

BELANGRIJK VEILIGHEIDSVOORSCHRIFT:

Deze eenheden voldoen aan de EN609501. Deze apparaten mag niet worden blootgesteld aan vocht. Vanwege het risico dat er druppels in het apparaat vallen, dient u er 
geen vloeistoffen in bekers op te plaatsen. Voor een veilig gebruik en om het gevaar van electrische schokken en het risico van brand te vermijden, dienen de volgende 
regels in acht te worden genomen:
o Controleer of de spanningscaroussel op het juiste Voltage staat.
o Gebruik alleen zekeringen van de aangegeven typen en waarden.
o Aansluiting van de unit alleen aan een geaarde wandcontactdoos.
o De netkabel die met de unit wordt geleverd, moet als volgt worden aangesloten:

Fase—Bruin        Nul—Blauw        Aarde—Groen/Geel
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 Chapter 1
Introduction

Welcome to Dolby® Atmos™.

Dolby Atmos is our latest innovation in audio technology, vastly expanding the palette for 
content creators and enhancing the audience experience in cinematic presentations. 

After you install, set up, and connect to your Dolby Atmos Cinema Processor CP850, as 
explained in the Dolby CP850 Quick Start Guide, this manual shows you how to calibrate an 
auditorium using the Dolby Atmos Designer software and how to operate the CP850 using 
the web client. 

You can set high-resolution multiple-rate equalization for all channels automatically using 
the Dolby Atmos Designer software or manually from the web client user interface.

This manual covers the following information:

• Positioning Microphones 
• Setting Up Audio Capture
• Installing Dolby Atmos Designer
• Launching Dolby Atmos Designer
• Designing a New Configuration
• Configuring the Speaker Parameters
• Assigning Arrays
• Configuring the Routing Parameters
• Configuring the Bass Management Parameters
• Running AutoEQ
• Connecting to the CP850
• Configuring Macros
• Displaying and Configuring the Equalization Parameters
• Displaying and Configuring the Auditorium Parameters
• Configuring Preferences
• Checking the Logs
• Setting Up User Access
• Modifying the Network Settings
• Performing Maintenance Tasks
• Rebooting the System
• Accessing Documentation
• Viewing Dolby Atmos Status in Show Manager
Dolby® Atmos™ Cinema Processor CP850 Software Manual 1



Introduction  
Questions or Feedback

If you have questions or comments regarding this document or another related document, 
please contact technical publications.

If you have technical questions regarding this product/technology, please contact technical 
support.
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mailto:documentation@dolby.com?subject=CP750&body=Please%20type%20your%20comments%20here,%20leaving%20the%20subject%20line%20in%20place%20to%20route%20them%20to%20the%20right%20people.%0A%0A
mailto:cinemasupport@dolby.com?subject=CP750&body=Type your comments here. Leave the subject line intact to insure proper routing.
mailto:cinemasupport@dolby.com?subject=CP750&body=Type your comments here. Leave the subject line intact to insure proper routing.


 Chapter 2
Using Dolby Atmos Designer

This chapter shows you how to use the Dolby® Atmos™ Designer software to calibrate an 
auditorium in a Dolby Atmos Cinema Processor CP850 playback environment. We also 
support this application for use in a postproduction environment with the Dolby 
Rendering and Mastering Unit (RMU), but this information is not required or included 
here. Information regarding the RMU is provided with that unit.

With Dolby Atmos Designer, you can calibrate your auditorium using its automated 
equalization (AutoEQ) capability. This application provides tools that enable you to 
measure the response of an auditorium and design and implement an equalization 
configuration. You can then obtain an equalized response, which approximates a desired 
target response curve, such as a flat response or the standard cinema X–curve. 

You can run Dolby Atmos Designer in online mode when you are connected to a Dolby 
Digital Cinema network that includes a CP850, or in offline mode when you are not 
connected. In offline mode, you can enter information regarding your auditorium and save 
a Dolby Atmos configuration (.dac) file. You can then reopen this file later to complete the 
process when you are online in your auditorium. 

This chapter covers the following information:

• Positioning Microphones 
• Installing Dolby Atmos Designer
• Setting Up Audio Capture
• Launching Dolby Atmos Designer
• Designing a New Configuration
• Configuring the Speaker Parameters
• Configuring the Amplifier Parameters
• Assigning Arrays
• Configuring the Routing Parameters
• Configuring the Bass Management Parameters
• Running AutoEQ

Note: Before you begin this process, follow the instructions in your Dolby CP850 Quick 
Start Guide and Dolby Atmos Cinema Processor CP850 Manual to install your CP850 
in a Dolby Digital Cinema network.
Dolby® Atmos™ Cinema Processor CP850 Software Manual 3



Using Dolby Atmos Designer  
2.1 Positioning Microphones 

This section assumes that you are online in your auditorium. If you are offline, proceed to 
Section 2.2.

To run Dolby Atmos Designer in online mode, you need the following equipment:

• Eight microphones 
• A supported audio interface 
• An external sound pressure meter 

Begin the configuration by positioning your microphones.

1. Place microphone 1 at the reference position, along the center line of the image at a 
point approximately two-thirds the length of the room.

2. Place microphones 2–8 at different positions within the room.
Position microphones 2–8 so they cover the middle to rear portion of the seating area. 

3. If possible, avoid the following:
• Do not place microphones 2–8 at points of symmetry. That is, avoid placing 

microphones half the distance between walls (antinode for all harmonics), 
one-third the distance between walls, or one-quarter of the distance between 
walls.

• Two microphones in the same node structure: Do not place microphone pairs 
with front/back or left/right symmetry. That is, avoid placing two microphones at 
the same distance from a parallel wall. (For example, if one microphone is placed 
15 feet from the left wall, do not place a second microphone 15 feet from the right 
wall.)

• Do not place microphones close to wall surfaces, hard partitions, equipment 
credenzas, or other surfaces that could cause errors in the measured frequency 
response due to sound reflections.    

• Do not place microphones in close proximity to an individual loudspeaker.

Figure 2-1 shows a typical auditorium microphone setup.
Figure 2-1  

Figure 2-1 Auditorium Microphone Setup

Microphone at reference position

Microphones 2–5

Microphones 6–8 (optional)
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 Positioning Microphones 
Microphone Angle and Elevation

Take the following precautions when positioning the angle and elevation of your 
microphones.

1. Position each microphone near the typical ear height of a seated person, but with 
enough distance from the seat to prevent frequency response errors due to sound 
reflections. 

2. Place microphone capsules no closer than 6 inches (15.24 cm) from the top of a seat 
and oriented straight up. 

Figure 2-2  

Figure 2-2 Microphone Relative to Seated Person Ear Height

2.1.1 Setting Up Audio Capture 

You continue the auditorium configuration by setting up audio capture.

Audio Capture Configuration

Figure 2-3 shows you how to set up a CP850 with a computer, PC audio interface, and 
microphones to perform audio measurements.

Figure 2-3  

Figure 2-3 Audio Capture Configuration

Caution: High-back chairs can prevent you from placing a microphone near the ear height 
of a seated person. In such a case, elevated seated ear height is desirable to avoid 
frequency response errors that result from sound reflecting off the seat.

90” (228.60 cm)

6” (15.24 cm)

PC soundcard

with multiple 
microphone inputs

Microphone cable

Dolby CP850
CAT5E

PCAuditorium

network

 

CAT5E 
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Using Dolby Atmos Designer  
Dolby Atmos Designer supports the following audio interfaces:

• Roland® Octa-Capture high-speed USB audio interface
• RME Micstasy with DiGiCo UB MADI Multichannel Audio Digital Interface (MADI) 

USB 2.0 connector

2.2 Installing Dolby Atmos Designer

The Dolby Atmos Designer software runs on Microsoft® Windows® 7. To install Dolby 
Atmos Designer:

1. Download the Dolby Atmos Designer software from 
https://www.dolbysecure.com/cinematech. You will need to set up a user ID and password 
to access this website. You can also download periodic software updates here.

2. Double-click on the Dolby Atmos Designer icon to begin the installation process, then 
follow the screen prompts.

2.3 Launching Dolby Atmos Designer

To launch Dolby Atmos Designer, click Start > Dolby Atmos Designer or click the shortcut 
on your desktop. 

The main menu screen appears. When you launch Dolby Atmos Designer, this screen 
always opens a new project, as indicated in the title bar as untitled Dolby Atmos 
configuration. 

Figure 2-4  

Figure 2-4 Main Menu Screen

In the main menu screen, you can:

• Design a new configuration (online or offline) 
• Open an existing configuration from disc (online or offline) 
• Pull an existing configuration from a CP850 (online)
• Push a configuration to a CP850 (online)
• Save a configuration to disc (online or offline), or push it to a CP850 (online) 
6 Dolby® Atmos™ Cinema Processor CP850 Software Manual 
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 Designing a New Configuration
• Configure preferences (online or offline)
• Show or clear logs (online or offline)

After opening an existing configuration, you can edit the respective settings.

2.3.1 Using the File Menu

In the File menu, you can open an existing configuration from your local disc, start a new 
configuration (if an existing configuration is open), or save your configuration settings. 

Figure 2-5  

Figure 2-5 File Menu

2.3.2 Pulling and Pushing a Configuration 

To pull an existing configuration from a CP850 or push an existing configuration to a 

CP850, click the pull configuration button or the push configuration 

 button, then click on the respective CP850 button, and enter the 
desired IP address at the prompt. 

2.4 Designing a New Configuration

To design a new configuration:

1. If Dolby Atmos Designer is not running, launch it by clicking Start > Dolby Atmos 
Designer or click the shortcut on your desktop.
An new untitled project opens in the main menu screen.

2. Click Preferences in the Edit menu.
Figure 2-6  

Figure 2-6 Select Preferences in the Edit Menu

Note: When you design or edit a configuration by making entries in the various screens, 
be sure to click Save in the File menu to save your settings.
Dolby® Atmos™ Cinema Processor CP850 Software Manual 7



Using Dolby Atmos Designer  
The Preferences screen appears. In this screen, you can select your ASIO device, enable the 
display of speaker labels in your speaker and array configurations, and specify your 
measurement units.

Figure 2-7  

Figure 2-7 Preferences Screen

3. Enter your preferences, then click OK.

4. Click the configuration designer  button.

The configuration designer screen appears. In this screen, you can configure a room and 
configure speakers and arrays online or offline. To run the automated equalization tool 
(AutoEQ), you must be online. 

Figure 2-8  

Figure 2-8 Configuration Designer Screen
8 Dolby® Atmos™ Cinema Processor CP850 Software Manual 



 Designing a New Configuration
2.4.1 Configuring the Auditorium

To configure your auditorium:

1. Click configure room . 

The configure room screen appears. In this screen, you click the wall and ceiling icons 
to enter the respective parameters for each area in your auditorium. You can also use 
the left and right arrows at the upper-right corner to move to the next or 
previous set of parameters. Figure 2-9 shows the screen wall parameters, which is the 
first set of parameters to appear. The active wall is always highlighted in blue, while 
inactive walls are highlighted in red. 

Figure 2-9  

Figure 2-9 Configure Room Screen (Screen Wall)

2. Enter the desired parameters for the screen wall. 

When you click the done button to confirm your settings (see step 8), the icons 
turn green (except for the active wall), which indicates that you entered complete and 
valid data (see Figure 2-15).

Screen wall
is active
parameter
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Using Dolby Atmos Designer  
3. Click the left or right icon. 

The left and right icons are highlighted in blue to indicate they are now active, and the 
left and right walls parameters appear, as shown in Figure 2-10. 

Figure 2-10  

Figure 2-10 Left and Right Walls Parameters 

4. Enter the desired left and right walls parameters in the respective fields.

5. Click the booth wall icon to enter the parameters for the booth wall and bass 

management subwoofers.
Figure 2-11  

Figure 2-11 Booth Wall and Bass Management Parameters 
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 Designing a New Configuration
6. Click the floor and ceiling icon (middle icon) to enter the respective parameters.
If the auditorium floor is flat, retain the default floor settings (0.000 m). If the 
auditorium ceiling is flat, enter the ceiling elevation at the screen for all three values.

Figure 2-12  

Figure 2-12 Floor and Ceiling Parameters

7. Click the room ID button at the bottom of the configure room screen to enter the 
desired information, then click OK. 

Figure 2-13  

Figure 2-13 Room ID Screen 

8. Click the done button at the bottom of the configure room screen. If your parameters 
are valid, the specified room configuration appears and the done button changes to an 
edit button, as shown in Figure 2-14. Clicking edit allows you to change any of your 
previously saved parameters. 
If you enter valid parameters, icons change to green, except for the active wall (see 
Figure 2-15). 

If you enter incomplete parameters but the data includes the minimum viable settings, 
icons are half white and half green. If you press the done button and your parameters 
are invalid, icons are red and an error message appears. In such a case, you must enter 
valid settings.
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Figure 2-14  

Figure 2-14 Room Configuration Summary

9. After entering complete valid parameters and clicking the done button, the respective 
icons change to green, except for the active wall, which is editable (see Figure 2-15).

Figure 2-15  

Figure 2-15 Editable Room Screens 
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2.4.2 Configuring the Speaker Parameters

To configure the speaker parameters:

1. Click configuration designer at the upper-left side of 
the screen.

2. Click configure speakers & arrays to display the 
parameters under the edit speaker tab.

Figure 2-16  

Figure 2-16 Configure Speakers and Arrays

3. To configure the parameters for a specific speaker, click on its icon at the left side of 
the screen. The speaker and amplifier profile database is prepopulated with read-only 
profiles. If your speaker model is not in the database, you can add a profile and edit it 
accordingly. Screen speaker x, y locations are read only.
You can also draw a marquee around a group of speakers and edit the parameters for 
that group, except when you enter the x and y coordinates for a speaker location (as in 
step 6). To add or remove a speaker, press <Ctrl> on your PC.

4. To select a speaker configuration, click in the profile field and assign the appropriate 
speaker model from the drop-down menu.
If your speaker model is not listed, proceed directly to step 5.

Figure 2-17  

Figure 2-17 Select Speaker Model

x

y

0,0

x, y speaker locations are in
relation to the plane
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When you select a speaker model, the manufacturer and speaker specifications 
automatically populate the respective fields, as shown in the following figures. 

Figure 2-18  

Figure 2-18 Configure Screen Speakers

Figure 2-19  

Figure 2-19 Configure Subwoofers
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Figure 2-20  

Figure 2-20 Configure Surrounds

5. If your speaker model is not listed, click the  button next to the speaker model 
field, then enter the manufacturer, the specifications (per the speaker data sheet), and 
optional data (if available) in the respective fields. The edit button changes to a 
save button. 
• Click save to save your custom speaker settings to your speaker database. To edit 

a custom configuration, click the edit button, change the desired settings, then 
click the save button.

6. If you need to manually override the speaker locations, use the x and y fields, then 
click apply x, y to confirm your entries. The x and y coordinates are in relation to the 
plane. 
If you are designating a speaker as an overhead, click in the is overhead box.

Figure 2-21  

Figure 2-21 Enter Speaker Location

7. Click apply chosen profiles to selected speakers to complete your settings using one of 
the provided setups. Repeat this step each time you select and assign a single speaker 
or a group of speakers.
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2.4.3 Configuring the Amplifier Parameters

To configure the amplifier parameters, click the amp tab and follow the same sequence that 
you performed for the speaker parameters. 

Figure 2-22  

Figure 2-22 Amplifier Parameters
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2.4.4 Assigning Arrays 

After configuring your speakers, as described in the previous section, you can assign the 
arrays as follows:

1. Click the array assignments tab. 
Figure 2-23  

Figure 2-23 Click Array Assignments Tab

The array assignments appears, as shown in Figure 2-24.

Dolby Atmos Designer automatically assigns speaker feeds to the arrays based on 
predefined rules. The colors of the speakers correspond to their array assignments, as 
shown Figure 2-24.

Figure 2-24  

Figure 2-24 Array Assignments

2. To change the speaker assignments:
• Click on a speaker to outline it with dashes.  
• Click the desired speaker assignment button.
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2.4.5 Configuring the Routing Parameters

After you assign arrays, click the routing tab to configure routing. 
Figure 2-25  

Figure 2-25 Click Routing Tab

The routing parameters appear. In this screen, you can apply Manual Routing routing to a 
specific speaker or Automatic Routing to a group of speakers.

Figure 2-26  

Figure 2-26 Routing Parameters 
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Manual Routing

To perform manual routing:

1. Click on a speaker to outline it .

2. In the manual routing pane, select an output that corresponds to the appropriate 
routing in the physical output drop-down menu. Alternatively, you can type the 
number of the desired output on your keyboard and press <Enter>.

Figure 2-27  

Figure 2-27 Select Output for Manual Routing

3. Repeat steps 1 and 2 for each speaker.
You can clear all of your selections by clicking the clear selected routings button.

Automatic Routing

Automatic routing follows these predefined rules:

• The autoassignment of the screen is left, right, center.
• The autoassignment for the left and right side and ceiling surrounds is screen to 

booth.
• The autoassignment for the rear surrounds is left, right, left, right, left, right until 

the system fully assigns the arrays

To apply automatic routing:

4. Draw a marquee around a group of speakers (or select them one at a time by pressing 
<Ctrl>).

Figure 2-28  

Figure 2-28 Select Group of Speakers for Automatic Routing
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5. In the automatic routing pane, select any analog output from the analog outputs to use 
drop-down menu.

Figure 2-29  

Figure 2-29 Select Analog Output for Automatic Routing

6. Select the output where you want to start the automatic routing operation in the auto 
assign from output drop-down menu.

Figure 2-30  

Figure 2-30 Assign First Output for Automatic Routing

7. Click the apply automatic routing button .

The automatic routing operation begins routing incrementally from the first speaker in 
the speaker group (according to the previously described automatic routing rules) 
until the process is completed.
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2.4.6 Configuring the Bass Management Parameters

After you configure the routing parameters, configure the bass management parameters 
for one or two subwoofers as follows:

1. Click the bass management tab.
Figure 2-31  

Figure 2-31 Click Bass Management Tab

2. Select speakers one at a time or by dragging a marquee around a group of speakers.
Do not select subwoofers. If you accidentally select subwoofers, press <Ctrl> on your 
keyboard to deselect them.

3. Assign the speaker or speakers to the bass management subwoofers.
4. Assign a bass management frequency to the group.
5. Click the apply button.

Figure 2-32  

Figure 2-32 Configure Bass Management
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2.4.7 Running AutoEQ 

After you configure your speakers and arrays, you can run AutoEQ, as follows:

1. Click the configuration designer  button.

2. Click run AutoEQ to display the AutoEQ screen, as shown in Figure 2-33.
Figure 2-33  

Figure 2-33 AutoEQ Screen

3. Click the connect button at the top of the screen.
Figure 2-34  

Figure 2-34 Click Connect 

A dialog box appears requesting an IP address for your CP850.
Figure 2-35  

Figure 2-35 Enter CP850 IP Address 
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4. Enter the CP850 IP address, and click connect in the dialog box.
Once connected, the connect button in the AutoEQ screen changes to a connected 
button and the color changes to green, indicating that you are now connected to your 
CP850. In addition, the CP850 IP address is displayed in the Windows title bar, as 
shown in Figure 2-36.

Figure 2-36  

Figure 2-36 Connected to CP850

Figure 2-37  

5. Select the number of microphone inputs you are using for the calibration. An x below 
any meter in the microphone input levels section indicates that the system will use the 
corresponding microphone input for the acquisition process. You cannot disable 
microphone 1.

6. Click the calibrate reference signal button.

The Reference Signal Calibration screen appears.
Figure 2-38  

Figure 2-37 Reference Signal Calibration Screen
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7. Unmute the signal by clicking the unmute button. 

The red unmute button changes to a gray mute button. This generates pink noise 
from the center speaker. The signal is attenuated by –20 dB. The sound pressure level 
(SPL) should be very low. Using an SPL meter increase the fader icon until the sound 
pressure level from the Center channel is 85 dBC. 

8. Click OK. 
9. After calibrating the reference signal, we recommend that you adjust the output gain 

of each speaker to optimize the dynamic range of the system:
• Turn on noise by clicking the check box at the top of the AutoEQ screen.
• Select pink noise as the test signal.
• Select the speaker feed by clicking the desired speaker icon on the left side of 

screen.
• Measure the C-weighted SPL at the reference position in the auditorium.
• Adjust the amplifier gain until the speaker output level is 85 dBC.
• Note the input gain adjustment. 
• Repeat the preceding steps for each speaker.
• Once the gain adjustments are complete for each speaker, turn off the pink noise. 

10. After setting all the speaker feeds to 85 dBC SPL, click configuration designer. 

at the upper-left side of the screen.

11. Click configure speakers & arrays .

12. Select a speaker feed by clicking a speaker on the left side of the screen.
13. Click on the amp tab.

14. Adjust the input trim based on the input gain adjustment. 
(See step 9, bullet 6.)

15. Repeat the preceding steps for each speaker based on the input gain adjustment. 
(See step 9, bullet 6.)

Note: Set the Low-Frequency Effects (LFE) channel to +10 dB inband-gain (~91 dBC SPL), 
and set bass management subwoofers to 0 dB inband-gain (~81 dBC SPL).
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16. Click the x-curve tab.

The x-curve parameters appear.
Figure 2-39  

Figure 2-38 Default X-Curve Parameters

17. Set the boost-level frequencies. 
Boost limits define the point where no boost above 0 dB is applied to frequencies above 
and below the high and low limits for a speaker or an array feed. The system 
automatically assigns default boost-limit frequency points to each speaker and array 
feed. To change the boost-limit frequency:

• Select a speaker at the left side of the screen, or draw a marquee around a group 
of speakers to edit the parameters for that group.  

• Select the AutoEQ results tab.  
• Edit the boost-limits value by typing in a value or using the up/down arrows.

18. Click the record button.

19. At the prompt, enter a file name and click save to save your file if you have not done 
so already.
Recording begins immediately. During a measurement, the speaker being measured 
flashes red and a signal is displayed on the input level meter. In addition, a progress 
bar appears at the bottom of the screen and the speaker being acquired is displayed 
below.

Note: Avoid setting boost limits to frequencies above or below the bandwidth limits of 
the speakers (± 3 dB points) to avoid excessive boost where the output of the 
speaker begins to rapidly decrease. 
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Figure 2-40  

Figure 2-39 Speaker Measurements

When the speaker feed measurement is completed, the system automatically starts 
processing data. Once processed, a speaker icon turns green.

Figure 2-41  

Figure 2-40 Processing Speaker Feed Data
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During the EQ process, you can view real-time results by clicking the AutoEQ results tab.
Figure 2-42  

Figure 2-41 AutoEQ Processing 

During speaker feed processing, the system automatically begins array measurements.
The arrays being measured flash red, measured arrays appear in yellow, and a signal 
appears on the input level meters. Array icons with no color indicate that there is no 
measurement data present. Some speakers are assigned to multiple arrays. Array icons 
that are half green and half yellow indicate that one of the arrays is processed and the 
other is not. Array icons that are completely green indicate that the array acquisitions 
were processed.

Figure 2-43  

Figure 2-42 Array Measurements
Dolby® Atmos™ Cinema Processor CP850 Software Manual 27



Using Dolby Atmos Designer  
At the end of the entire process, a message indicates that AutoEQ is completed.
Figure 2-44  

Figure 2-43 AutoEQ Completed

20. Click OK.
Once the equalization process is complete, we recommend that you inspect each 
speaker feed and array feed to confirm that the equalization and levels are 
appropriate:  

• Select a speaker feed by clicking a speaker icon on the left side of the screen.
• Navigate to the AutoEQ results tab.
• Observe the gain value for each speaker feed and equalization curve.
• If the gain or equalization seems incorrect for a speaker feed, you can: 
a. Remeasure the speaker by clicking on a speaker at the left side of the screen, or 

select multiple speakers by pressing <Ctrl> and clicking on the desired speakers. 
You can also draw a marquee around a group of speakers.  Remeasure by 
pressing the rec button.

b. Update the speaker by clicking on a speaker at the left side of the screen, or select 
multiple speakers by using the methods described in step a. Change a value, such 
as a boost-limit frequency or x-curve parameter.  Select update to reprocess the 
data with the edited value.

21. Click the Configuration Designer button. 
22. Click the Main Menu button.
23. Click Save Configuration.
24. Click Push to CP850.

If you are connected to a CP850, the system pushes the Dolby Atmos configuration .dac 
file to your unit. If you are not connected to a CP850, you must enter an IP address at 
the prompt before the system pushes the EQ file to your unit. 

A warning message with a backup prompt appears. You can ignore this warning and 
click overwrite. However, if you need to back up the existing .dac file on the CP850, use 
the CP850 web client, as described in Section 3.9.

Figure 2-45  

Figure 2-44 Backup Prompt

Note: If you update a surround speaker, the system remeasures the array to which the 
speaker feed is assigned.
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When the system writes the Dolby Atmos configuration (.dac) file to the CP850, a 
confirmation dialog box appears. 

Figure 2-46  

Figure 2-45 Configuration Pushed Confirmation 

25. Click Save As in the File menu to save your .dac file to the desired directory on your 
PC as a backup. You can also transfer these settings directly to another CP850. 

Figure 2-47  

Figure 2-46 Save Dolby Atmos Configuration File Backup

Dolby Atmos Configuration File Contents

The .dac file contains the following information, which includes speaker data:

• Site information
• Room configuration
• Speaker type
• Amplifier type
• Output routing
• Speaker location
• Limiter settings
• Bass management routing (if used)
• Bass management frequency
• Equalization data for speakers and arrays
• File version data
• Indexes to capture data for a given session

For information on using the web client backup and restore functions to load .dac files that 
contain additional data from web client settings, see Performing Maintenance Tasks.
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 Chapter 3
Using the Web Client User Interface

After using Dolby® Atmos™ Designer software to calibrate your auditorium, this chapter 
shows you how to operate the CP850 using the web client user interface. It covers the 
following information:

• Connecting to the CP850
• Configuring Macros
• Displaying and Configuring the Equalization Parameters
• Displaying and Configuring the Auditorium Parameters
• Configuring Preferences
• Checking the Logs
• Setting Up User Access
• Modifying the Network Settings
• Performing Maintenance Tasks
• Rebooting the System

• Accessing Documentation

Note: Before you begin, follow the instructions in your Dolby CP850 Quick Start Guide to 
install your CP850 in a Dolby Digital Cinema network, and refer to Chapter 2 for 
information on calibrating an auditorium.
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3.1 Connecting to the CP850
After you install the CP850, as described in the Dolby CP850 Quick Start Guide, connect your 
computer to the CP850:

1. Connect your computer to the auditorium network switch.
2. Open the web browser on your computer. Currently, the CP850 is compatible with 

Mozilla® Firefox® v3.5 or later, Google™ Chrome™ v5.0 or later, Apple® Safari® v6.0 or 
later, and Microsoft® Internet Explorer® v8.0 or later. 

3. Connect to the CP850 by typing its IP address in your web browser.
A login screen appears requesting a user name and password, as shown in Figure 3-1. 
The default administrator user name and password are both admin. If you are a system 
administrator, you should change the administrator password, and then set up user 
access levels and passwords for all other users, as described in Section 3.7.

Figure 3-1  

Figure 3-1 Login Screen

After you log in, the CP850 web client status screen appears, as shown in Figure 3-2.
Figure 3-2  

Figure 3-2 CP850 Web Client Status Screen
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Following is a description of all of the objects that appear in each of the web client 
user-interface screens.

3.1.1 Navigation Bar

The CP850 navigation bar provides access to all of the CP850 status, setup, and system  
screens. Click the desired menu option to display the corresponding screen.

Figure 3-3  

Figure 3-3 Navigation Bar

3.1.2 Active Macro Field

In this field, you can select the desired macro to use for your input source. The CP850 
requires macros to process audio. You can use the default macros that are provided with 
the system, or you can create your own macros. For more information, see Section 3.2. 

Figure 3-4  

Figure 3-4 Active Macro Menu
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3.1.3 Monitor Field

In this field, you can select a channel for booth monitor output.
Figure 3-5  

Figure 3-5 Monitor Menu

3.1.4 Mute Button

You can click this button to mute and unmute the system.
Figure 3-6  

Figure 3-6 Mute Button

3.1.5 Fader Field

You can increase or decrease the volume by clicking the + or – buttons or by entering the 
desired value in this field.

Figure 3-7  

Figure 3-7 Fader Field

3.1.6 Audio Meter

This meter displays the audio levels for channel-based audio. It shows the signal intensity 
of PCM input channels, decoded bitstreams, and upmixed content. When decoding a 
Dolby Atmos soundtrack, this meter shows the intensity of object audio and bed audio.

Figure 3-8  

Figure 3-8 Audio Output Meter
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3.2 Configuring Macros

The CP850 requires macros to process audio. The system provides you with the following 
default macros that you can use, edit, or discard. 

• 5.1 + Dolby Atmos

• 7.1 Dolby Surround + Dolby Atmos

• AES 2ch – BNC 1

• AES 2ch – BNC 2

• Non-Sync

• PA Microphone

• RCA

• S/PDIF Optical

In addition, you can create macros from scratch. To configure a macro and assign it to a 
front-panel button and GPIO input, select macro editor in the setup menu.

Figure 3-9  

Figure 3-9 Select Macro Editor in Setup Menu

The macro editor screen appears, as shown in Figure 3-10 for a 7.1 Dolby surround input 
source. In this screen, you can create or edit a macro by entering the desired parameters. 

Figure 3-10  

Figure 3-10 Macro Editor Screen
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Figure 3-11 identifies all of the parameters in the macro editor screen. This example uses a 
7.1 Dolby Surround format. The available parameters can change, based on your input 
source.

Figure 3-11  

Figure 3-11 Configure Macro for 7.1 Dolby Surround

Create New Macro

1. Click the  button to create a new macro or the edit button to edit an 
existing macro.
If you click either of these buttons, the parameter fields are now active and you can 
enter the desired settings. In addition, the edit button changes to a save button and a 
cancel button appears . The cancel button allows you to cancel your 
entries. 

2. Configure the desired parameters in the macro editor screen.
Following is a description of all the parameters in the macro editor screen. The available 
parameters can change, based on your input source. After configuring all of the 
parameters, click the save button.

Select macro

Edit macro

(changes to

Select input
source

Select format

Assign
front-panel 
button and 
GPIO input

Enter global
audio delay

Select EQ
preset

Configure
channel 
assignment

Configure
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save button
after clicking)

Create new macro Delete macro
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Macro Selection

Click in this field to select the macro that you want to edit. 

If you click the  or  button, you can enter a name for your macro in this field.
Figure 3-12  

Figure 3-12 Select Macro to Configure

Delete Macro

Click the  button to delete the selected macro.

Front-Panel Button and GPIO Input

Click in this field to assign a front-panel button and GPIO automation input for your 
macro.

Figure 3-13  

Figure 3-13 Select Front-Panel Button and GPIO Input 

Fader Preset

Click in this field to enter a fader value and slide to the ON or OFF position to activate or 
deactivate the fader for your macro.

Figure 3-14  

Figure 3-14 Enter Fader Preset 
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Global Audio Delay (ms)

Click in this field to enter a global audio delay (in milliseconds) for your macro. You need 
to add picture delay to the DSS200 or DSS220 media block when using 16-channel input. 
(For details, refer to the Media Block setup instructions in your Dolby Digital Cinema System 
Manual.)

Figure 3-15  

Figure 3-15 Enter Global Audio Delay 

Input

Click in this field to select the desired input source.
Figure 3-16  

Figure 3-16 Select Input Source

Format 

Click in this field to select the desired audio format.
Figure 3-17  

Figure 3-17 Select Audio Format

Channel Assignment

Click this button to assign channels. If you click on the custom preset button, you can 
customize the channel assignment by clicking in the respective field, as shown in 
Figure 3-18.

Figure 3-18  

Figure 3-18 Configure Custom Channel Assignment
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Dolby Bitstream Configuration

Click this button to select the Dolby bitstream configuration.
Figure 3-19  

Figure 3-19 Configure Dolby Bitstream

If you select one of the upmix modes, you can enable the subwoofer by moving the slider 
to the ON position for the subwoofer parameter.

Figure 3-20  

Figure 3-20 Enable Subwoofer for Dolby Bitstream

EQ Preset

Click on this field to select the equalization preset parameters. These parameters are either 
the automated equalization (AutoEQ) settings or custom settings that you can create, as 
described in Section 3.3.

Figure 3-21  

Figure 3-21 Select an EQ Preset
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3.3 Displaying and Configuring the Equalization Parameters

To display and configure the equalization parameters:

1. Select equalization in the setup menu.
Figure 3-22  

Figure 3-22 Select Equalization in Setup Menu

The real-time analyzer (RTA) EQ display appears in the equalization screen. In this 
screen, you can create or edit equalization settings based on the AutoEQ parameters or 
any custom (preset) parameters. 

Figure 3-23  

Figure 3-23 Displaying and Configuring the Real-Time Analyzer EQ Display 

1. Click the  button to add a new equalization file, or click the edit button to 
edit an existing file.
The edit button changes to a save button, and a cancel button appears . 
The cancel button allows you to cancel your entries. 

Note: You cannot change any of the AutoEQ parameters unless you save these settings 
under a different name.

RTA EQ 
display
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2. Configure the desired parameters in the equalization screen.
Following is description of all the parameters in the equalization screen. After 
configuring all of the parameters, click the save button.

Delete Button

Click the button to delete a custom equalization preset. You cannot delete the AutoEQ 
preset.

EQ Presets 

Click in this field to select an equalization file to edit or to add a new file.
Figure 3-24  

Figure 3-24 Select AutoEQ or LocalEQ

If you select a custom preset to edit, the edit button is activated. If you click the edit 

button, a message informs you that if you proceed, audio is interrupted.
Figure 3-25  

Figure 3-25 Editing Equalization Warning Message

Click proceed to edit your preset. All of the equalization parameters are now activated for 
editing.
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Figure 3-26  

Figure 3-26 Equalization Parameters Activated for Editing

If you click the  button to add a new equalization preset, you are prompted to base your 
preset on either the AutoEQ settings or a previously created custom preset. In either case, 
you must also enter a name for your new preset.

Figure 3-27  

Figure 3-27 Add an EQ Preset

When you enter a name for your new preset, an ok button appears.
Figure 3-28  

Figure 3-28 Click OK to Save New Preset

Click ok to save your new preset. The warning message, as shown in Figure 3-25 appears.

Click proceed to edit your preset. The equalization parameters are now activated for 
editing, as shown in Figure 3-26.
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Pink Noise and Real-Time Analyzer Microphone Phantom Power 

You can turn these parameters on and off by dragging the respective sliders. In addition, 
you can rotate and snap pink noise by clicking in the respective boxes and selecting an 
option from the pink noise drop-down menu.

Figure 3-29  

Figure 3-29 Pink Noise and Real-Time Analyzer Phantom Power Parameters

Array Speaker Feeds 

Click in this field to select an array speaker feed. This field is always active. You can select 
from the drop-down menu or use the arrow buttons to scroll through the list.

Figure 3-30  

Figure 3-30 Array Speaker Feeds 

Bypass AutoEQ

This parameter specifies that the system will bypass the AutoEQ parameters and use the 
specified custom preset. You can move the slider to the ON or OFF position to enable or 
disable this parameter. 

Figure 3-31  

Figure 3-31 Bypass AutoEQ

Note: When you select ON, the system bypasses AutoEQ only for the channel you are 
currently editing (as specified in the array speaker feed drop-down menu, as 
shown in Figure 3-30).
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All Output Levels

Click this button to display the output levels for each speaker in your preset. Select an 
individual speaker by clicking on it, or press <Ctrl> on your keyboard to select multiple 
speakers. You can use the slider to specify output levels. In addition, you can 
enable/disable pink noise in this screen. Click ok to confirm your entries.

Figure 3-32  

Figure 3-32 All Output Levels Screen 

Copy Speaker EQ

Click this button to copy manual speaker EQ settings from one source to one or more 
destinations. When you drag a speaker to a new location, the copy button is activated and 
you can click on this button to confirm the location.

Figure 3-33  Cop

Figure 3-33 Manual Speaker EQ
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Real-Time Analyzer EQ Display Slider

Drag this slider or click the up and down arrow buttons to view different areas of the RTA 
EQ display.

Figure 3-34  

Figure 3-34 Real-Time Analyzer EQ Display Slider

Graphic Equalizer

Click on the graphic eq button and drag each slider to adjust the gain of the range of 
frequencies, as shown on the RTA EQ display. Click the flatten button to flatten the curve.

Figure 3-35  

Figure 3-35 Graphic Equalizer

Base and Treble

Click on the bass & treble button, drag the corresponding sliders, and change settings to 
adjust each parameter, as shown on the RTA EQ display. Click the flatten button to flatten 
the curve.

Figure 3-36  

Figure 3-36 Bass and Treble
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Output Level

Click on the output level button and drag the corresponding slider to adjust the output 
level. Click the flatten button, to flatten the output level.

Figure 3-37  

Figure 3-37 Output Level

3.4 Displaying and Configuring the Auditorium Parameters

To display the auditorium configuration summary and routing information:

1. Select auditorium in the setup menu.
Figure 3-38  

Figure 3-38 Select Auditorium in Setup Menu

The auditorium screen appears, with the speakers displayed according to their x and y 
coordinates, and the corresponding summary information.

Figure 3-39  

Figure 3-39 Display the Room Configuration Summary 
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 Displaying and Configuring the Auditorium Parameters
When you hover your mouse on any of the solid-colored icons, the following information 
appears: channel name, position, array (if assigned to an array), routing, speaker data (if 
populated), and bass management assignment (indicating the speaker that is bass 
managed) if bass management is applied. 

If you have multiple speaker feeds with the same positional data, a multicolored icon 
appears. When you click on this icon, it indicates the speakers that share this positional 
data. 

Figure 3-40  

Figure 3-40 Hover Mouse to Display Additional Information

2. Click the routing button.
The routing screen appears. In this screen, the output routing channel is identified 
within each icon. If it is a digital output, the routing icon is a square. If it is an analog 
output, the routing icon is a circle.

Figure 3-41  

Figure 3-41 Routing Screen
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When you hover your mouse on any of the solid-colored icons, the following information 
appears: channel name, position, array (if assigned to an array), routing, speaker data (if 
populated), and bass management assignment (indicating the speaker that is bass 
managed) if bass management is applied.

Figure 3-42  

Figure 3-42 Hover Mouse to Display Channel Information

3. Click the array delays button.
The surround speaker array delays screen appears. The Dolby Atmos Designer software 
automatically creates the surround delay values. If you slide the use configuration file 
values to the ON position, the system uses those values. If you slide it to the OFF 
position, you can enter the desired delay values.

Figure 3-43  

Figure 3-43 Surround Speaker Array Delays Screen
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 Configuring Preferences
Figure 3-44  

Figure 3-44 Hover Mouse to Display Additional Information

3.5 Configuring Preferences

To configure preferences, select preferences in the system menu.
Figure 3-45  

Figure 3-45 Select Preferences in System Menu

The preferences screen appears. In this screen, you can enter the mute duration and 
activate or deactivate the GPIO analog fader. The fade in and fade out settings each have a 
range of 0.2 to 5 seconds, in 0.1-second steps. You can set these values by moving the 
respective sliders.

Figure 3-46  

Figure 3-46 Preferences Screen
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3.6 Checking the Logs

The logs display information regarding the incoming signal and the system. To check the 
logs status, select logs in the system menu.

Figure 3-47  

Figure 3-47 Select Logs in the System Menu

The logs screen appears. You can filter the logs by level, category, and start time/end time by 
clicking the respective area and making the desired selection, or by clicking show all to 
remove all filters. In addition, you can download a .zip file by clicking download or clear the 
list of events by clicking clear events. 

Figure 3-48  

Figure 3-48 Event Logs Screen (All Levels, All Categories Selected)
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 Checking the Logs
When you click the level field, the corresponding drop-down menu appears, where you can 
select the user log display level, as shown in Figure 3-49.

Figure 3-49  

Figure 3-49 Level Menu

Category

When you click the category field, the corresponding drop-down menu appears, where 
you can select the user log display category, as shown in Figure 3-50.

Figure 3-50  

Figure 3-50 Category Menu

Start Time/End Time

When you click the start time or end time field, two options appear: All and Custom. All 
specifies a log for all time frames. Custom activates the date and time fields, where you can 
select a specific time frame. Click the  to display the specified log. If you click the , the 
system displays all time frames (same as All).

Figure 3-51  

Figure 3-51 Start Time/End Time Fields
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3.7 Setting Up User Access

If you have administrator privileges, you can set up user access as follows:

1. Select user access in the system menu.
Figure 3-52  

Figure 3-52 Select User Access

The user access screen appears. In this screen, if you are a system administrator, you 
can change (or reset) the default administrator password (admin) and set up (or reset) 
user access and passwords for all other users. 

Figure 3-53  

Figure 3-53 User Access Screen

To set up user access:

1. Click the username field.
The username menu appears with a list of all the user levels. 

Figure 3-54  

Figure 3-54 User Name Menu
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 Modifying the Network Settings
2. Select a user name, enter the old password, enter the new password, and then confirm 
the new password in the respective fields. The default passwords are the same as the 
user names.
Following are the capabilities at each user level:

• operator: Access status screen, change macros, fader, and monitor selection. View 
auditorium configuration and event logs. Download event logs.

• manager: Access all operator-level tasks, and edit macros and assign them to 
front-panel buttons. Change the operator-level password.

• technician: Access all manager-level tasks. Perform manual equalization, change 
network settings, clear event logs, update system software, manage system settings, 
reboot system, change the operator- and manager-level passwords, and update the 
certificate.

• admin: Access all technician-level tasks, and change the operator-, manager-, and 
technician-level passwords.

3.8 Modifying the Network Settings

To modify the network settings, select network in the system menu.
Figure 3-55  

Figure 3-55 Select Network in the System Menu

The network screen appears. In this screen, you can change the host name and modify 
the IP configuration for the command port and the Dolby Atmos input port.

Figure 3-56  

Figure 3-56 Modifying the Network Settings
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3.9 Performing Maintenance Tasks

If you are a technician or a system administrator, select maintenance in the system menu to 
perform maintenance tasks.

Figure 3-57  

Figure 3-57 Select Maintenance in the System Menu

The maintenance screen appears. In this screen, you can download the CP850 
certificate, upgrade the system, and manage settings. 

Figure 3-58  

Figure 3-58 Maintenance Screen
54 Dolby® Atmos™ Cinema Processor CP850 Software Manual 



 Performing Maintenance Tasks
Following is a description of each of the maintenance screen operations.

CP850 Certificate

The CP850 certificate identifies your unit. Your content distributor includes the certificate 
in all key delivery messages (KDMs) in the trusted device list to authorize the playback of 
content by your unit. Download this certificate to your local disk by clicking the download 
button, and send it to your content distributor upon request.

System Upgrade

To upgrade your system:

1. Obtain the .dlb upgrade file from Dolby Laboratories at 
https://www.dolbysecure.com/cinematech.

2. Copy the upgrade file to your local disk.
3. Click Choose File, then click upload.
4. Confirm the displayed upgrade file version, then click install upgrade.

The system initiates the upgrade process, displays the progress, and reboots the CP850 
when the upgrade is completed.

Settings Management

To perform settings management tasks:

• Click the backup button to save your CP850 system settings (.dac file) in your 
designated Downloads directory on your PC.

• Click the restore button at the upper-right side of the screen, then click Choose File to 
select a .dac restore file. You can restore all of your system settings (except user access) 
or select specific settings by clicking in the corresponding boxes. Click the restore 
button at the lower-right side of the screen to run the restoration process.

• Click the reset button at the upper-right side of the screen. You can reset all of your 
system settings to factory defaults (except for user access) or reset specific factory 
settings by clicking in the corresponding boxes. Click the reset button at the 
lower-right side of the screen to run the reset operation.
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3.10 Rebooting the System

If you have technician- or administrator-level access, you can reboot the CP850 from the 
web client by clicking reboot in the system menu.

Figure 3-59  

Figure 3-59 Rebooting the System

3.11 Accessing Documentation

To access the CP850 hardware manual and the Dolby Atmos Cinema Installation Submission 
form, click manuals in the system menu.

Figure 3-60  

Figure 3-60 Select Manuals
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 Chapter 4
Viewing Dolby Atmos Status in Show Manager

When you play back Dolby® Atmos™ content on your DSS200 or DSS220, Dolby Show 
Manager displays related status information. This chapter shows Dolby Show Manager 
screens that may appear in various states when you play back Dolby Atmos content.

4.1 Show Manager Dolby Atmos Content Identification

This section describes Show Manager screens that identify Dolby Atmos content.

4.1.1 Show Manager Control Screen

The Show Manager control screen displays an A in all Dolby Atmos clip icons, verifies the 
license, and indicates that Dolby Atmos audio is playing (via a green indicator on the 
lower-right side). In addition, Dolby Atmos auditorium icons display an A in all Show 
Manager screens.

Figure 4-1  

Figure 4-1 Show Manager Control Screen
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4.1.2 Show Manager Build Screen

The Show Manager build screen displays an A in all Dolby Atmos show and clip icons.
Figure 4-2  

Figure 4-2 Show Manager Build Screen

4.1.3 Show Manager Schedule Screen

The Show Manager schedule screen shows various Dolby Atmos icons related to shows 
and related hardware (CP850 and CAT745). An A appears in all Dolby Atmos show icons. 

Figure 4-3  

Figure 4-3 Show Manager Schedule Screen

Dolby Atmos
auditorium

Dolby Atmos clips

(show not
running)

Dolby Atmos
shows

CP850 and CAT745
Dolby Atmos information

Dolby Atmos
auditorium

Dolby Atmos
shows

(show not
running)
58 Dolby® Atmos™ Cinema Processor CP850 Software Manual 



 Show Manager Dolby Atmos Error States
4.2 Show Manager Dolby Atmos Error States

This section describes Show Manager screens that identify Dolby Atmos error states.

4.2.1 Show Manager Control Screen (Dolby Atmos License Missing)

The Show Manager control screen displays a flashing yellow indicator when a Dolby 
Atmos license is missing for encrypted content. In such a case, the show plays back with 
main audio only.

Figure 4-4  

Figure 4-4 Show Manager Control Screen Indicates Dolby Atmos License Is Missing

4.2.2 Show Manager Control Screen (Dolby Atmos Error Message)

The Show Manager control screen displays a flashing red indicator when a cable is 
disconnected, when Dolby Atmos content is corrupted, or for other issues. In such a case, 
the show plays back with main audio only.

Figure 4-5  

Figure 4-5 Show Manager Control Screen Indicates Problem with Dolby Atmos Content 
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